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คำนำ 

 
 
 

  เอกสารประกอบการเรียนการสอนฉบับนี้ ได้จัดทำขึ้นเพ่ือใช้เป็นสื่อเสริมประกอบหลักสูตรทองถิ่น 
เรื่อง งานไม้สวยด้วย SketchUp รายวิชาการออกแบบผลิตภัณฑ์ สำหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5     
กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี อีกทั้งยังเป็นบทเรียนที่นักเรียนสามารถเรียนรู้ได้ด้วย
ตนเองตามศักยภาพของแตล่ะบุคคล  
 หลักสูตรท้องถิ่น เรื่อง งานไม้สวยด้วย SketchUp ช่วยให้ผู้สอนได้จัดประสบการณ์ให้ผู้เรียนได้ 
ความรู้พร้อมทักษะปฏิบัติ ครูผู้สอนต้องจัดให้ผู้เรียนได้เข้าศึกษา ทำกิจกรรมทุกขั้นตอนตามที่กำหนด ทำให้
มีความจำเป็นต้องจัดทำเอกสารประกอบหลักสูตรท้องถิ่นฉบับนี้ขึ้น เพ่ือให้นักเรียนได้ศึกษาใบความรู้และ
จัดทำใบงาน ฝึกทักษะปฏิบัติ ทำกิจกรรมการเรียนการสอนได้ถูกต้องอย่างมีประสิทธิภาพ  
 ข้าพเจ้าหวังเป็นอย่างยิ ่งว่า เอกสารประกอบการเรียนการสอนฉบับนี้  คงเป็นประโยชนกับ       
การเรียนการสอนกับผู้ที่สนใจศึกษาคนควาพอสมควร 

 
                                    หนึ่งฤทัย  พุทธแก้ว 
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สารบัญ 
              หน้า 
คำนำ 
สารบัญ  
คำชี้แจง 
หน่วยที่ 1 สำรวจข้อมูลพื้นฐาน (Research) 
         ความหมายและความเป็นมาของการออกแบบ 
         ใบงานที่ หน่วยที่ 1 
         แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หน่วยที่ 1 
หน่วยที่ 2 สร้างแรงบันดาลใจ (Inspire) 
         ภูมิปัญญาท้องถิ่น 
         ใบงานที่ หน่วยที่ 2 
         แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หน่วยที่ 2 
 หน่วยที่ 3 ร่วมมือกันออกแบบ (Together Design) 
         การวาดรูปร่างโมเดล 
         ใบงานที่ หน่วยที่ 3 
         แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หน่วยที่ 3 
หน่วยที่ 4 สร้างเรื่องราวงานไม้ (Product Design) 
         การตกแต่งโมเดล 
         ใบงานที่ หน่วยที่ 4 
         แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หน่วยที่ 4 
หน่วยที่ 5 ประชาสัมพันธ์สู่มวลชน (Public Relations) 
         การบันทึกการปฏิบัติงานและการประเมินผลการออกแบบผลิตภัณฑ์งานไม้ 
         ใบงานที่ หน่วยที่ 5 
         แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หน่วยที่ 5 
แบบทดสอบก่อนเรียน-หลังเรียน 
เอกสารอ้างอิง 
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คำชี้แจง 

 
1. อ่านคำชี้แจงให้ละเอียดเพื่อประโยชน์ ในการศึกษาบทเรียน 
2. พยายามศึกษาและปฏิบัติกิจกรรมอย่างเต็มความสามารถเพราะเป็นกิจกรรม 
    ที่จะใช้เป็นพ้ืนฐานในการออกแบบผลิตภัณฑ์งานไม้ต่อไป 
3. นักเรียนต้องตั้งใจปฏิบัติงาน ไม่ก่อนกวนผู้อ่ืน และไม่ชักชวนเพื่อให้ออกนอกลู่นอกทาง 
4. นักเรียนต้องมีความซื่อสัตย์ โดยการทำใบงาน และแบบทดสอบด้วยตนเอง 
    โดยไม่ดูเฉลย เพ่ือให้ได้รับความรู้ในเนื้อหาจริง ๆ  
5. สืบค้นเพ่ิมเติมในเว็บไซต์ http://www.chr.ac.th/206/index.html และเว็บไซต์ 
    ที่เก่ียวข้อง 

 
 
 
 

ผลการเรียนรู้ 
 

1. อธิบายความรู้พื้นฐานการออกแบบผลิตภัณฑ์ 
2. สำรวจและวิเคราะห์ข้อมูลพ้ืนฐานการออกแบบผลิตภัณฑ์ได้อย่างถูกต้อง 
3. อธิบายหลักการใช้เครื่องมือในการออกแบบผลิตภัณฑ์ อย่างมีความคิดสร้างสรรค์ 
4. อธิบายและเลือกใช้เครื่องมือในการออกแบบผลิตภัณฑ์ด้วยโปรแกรม Sketchup   
    และวางแผนการปฏิบัติการสร้างชิ้นงานได้อย่างเหมาะสม 
5. สรุปประเมินผลและเผยแพร่ผลงาน การออกแบบผลิตภัณฑ์งานไม้สวยด้วย Sketchup 
    ได้อย่างเหมาะสม 
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หน่วยที่ 1 

ส ำรวจข้อมูลพื้นฐำน 

Research 
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          จดุประสงค์การเรียนรู้ 
 

1. ความหมาย ความสำคัญของการออกแบบผลิตภัณฑ์  
2. คุณสมบัติ องค์ประกอบของการออกแบบผลิตภัณฑ์ 
3. รู้จักโปรแกรม SketchUp 
4. การเรียกใช้โปรแกรม SketchUp 

 
 
       สาระสำคัญ 
 
   งานไม้สวยด้วย Sketchup เป็นการออกแบบผลิตภัณฑ์งานไม้สวยด้วย Sketchup ที่เกิดจาก 
การศึกษา วิเคราะห์ ออกแบบผลิตภัณฑ์จากวัสดุที่ทำจากไม้ และพัฒนางานด้วยตัวของ นักเรียนเอง โดยใช้
ข้อมูลความรู้จากการศึกษาค้นคว้า การสำรวจ ข้อมูลการออกแบบผลิตภัณฑ์งานไม้ในท้องถิ่น การศึกษา    
ดูงานแล้วนำมาวิเคราะห์อัตราส่วนการสร้างโมเดลโครงร่างพื้นที่ของชิ้นงาน โดยใช้วัสดุ อุปกรณ์ เป็น ไม้ที่
เป็นเอกลักษณ์ท้องถิ่น เช่น โต๊ะ เก้าอ้ี ม้านั่ง ตู้เสื้อผ้า ชั้นวางหนังสือ เครื่องมือ เครื่องใช้ที่เกิดจากภูมิปัญญา
มาใช้ในการออกแบบผลิตภัณฑ์งานไม้ เพ่ือให้เกิดคุณค่าทั้งด้านความงามและประโยชน์ใช้สอย 
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 ความหมาย ความเป็นมาของการออกแบบ 
 

  
 

การออกแบบ (Design) หมายถึง การถ่ายทอดรูปแบบจากความคิดออกมาเป็นผลงาน ที่ผู ้อ่ืน
สามารถมองเห็น รับรู้ หรือสัมผัสได้ เพื่อให้มีความเข้าใจในผลงานร่วมกัน โดยมีความสำคัญอยู่หลาย
ประการ กล่าวคือ ในแง่ของการวางแผนการทำงาน งานออกแบบจะช่วยให้การทำงานเป็นไปตามขั้นตอน
อย่างเหมาะสมและประหยัดเวลา ดังนั้นอาจถือว่าการออกแบบ คือ การวางแผนการ ทำงานก็ได้ ในแง่ของ
การนำเสนอผลงานนั้น ผลงานออกแบบจะช่วยให้ผู ้เกี ่ยวข้องมีความ เข้าใจตรงกันอย่างชัดเจน ดังนั้น
ความสำคัญในด้านนี้ คือ เป็นการสื่อความหมาย เพื่อความเข้าใจระหว่าง กัน เป็นสิ่งที่อธิบายรายละเอียด
เกี่ยวกับงาน งานบางประเภทอาจมีรายละเอียดมากมายซับซ้อน ผลงานออกแบบจะช่วยให้ผู้เกี่ยวข้อง และ
ผู้พบเห็นมีความเข้าใจที่ชัดเจนมากขึ้น หรืออาจกล่าวได้ว่า ผลงานออกแบบ คือตัวแทนความคิดของ
ผู้ออกแบบ ได้ทั้งหมดนั่นเอง 

 

ที่มา : www.tcdcconnect.com/greenforum 

 
การออกแบบ คือ กิจกรรมการแก้ปัญหาเพื่อให้บรรลุตามเป้าหมายหรือจุดประสงค์ที่ตั้งไว้     เป็น 

การกระทำของมนุษย์ด้วยจุดประสงค์ที่ต้องการแจ้งผลเป็นสิ่งใหม่ ๆ มีทั้งที่ออกแบบเพื่อสร้างขึ้นใหม่ ให้
แตกต่างจากของเดิมหรือปรับปรุงตกแต่งของเดิม ความสำคัญของการออกแบบเป็นขั้นตอน เบื้องต้นที่จะทำ
ให้กระบวนการในการผลิตสินค้าหรือผลิตภัณฑ์ประสบความสำเร็จในตลาดและตรง ตามเป้าหมาย 

     งานออกแบบคือ สิ่งที่มนุษย์สร้างขึ้นโดยการเลือกนำเอาองค์ประกอบมาจัดเรียงให้เกิดรูปทรงใหม่ที่
สามารถสนองความต้องการตามจุดประสงค์ของผู้สร้างและสามารถผลิตได้ด้วยวัสดุและกรรมวิธีการผลิตที่มี
อยู่ในขณะนั้น      
 

http://www.tcdcconnect.com/greenforum
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                           คุณสมบัติผลิตภัณฑ์ นกัออกแบบที่ดี 

 
 

เป็นที่ยอมรับ (Regional acceptance) ผลิตภัณฑ์นั้นจะต้องมีความแข็งแรง คงทนต่อ สภาพ
การใช้งาน หรือมีอายุการใช้งานที่เหมาะสมกับลักษณะของผลิตภัณฑ์และราคาที่จำหน่าย 

1. แก้ไขปัญหางานออกแบบ  และสามารถยกระดับคุณภาพชีวิตของมนุษย์ให้ดีขึ้น 
2. เป็นผู้ที่มีความคิดริเริ่มในการสร้างสรรค์งานออกแบบ  ให้สอดคล้องกับความต้องการของ สังคม

ทั้งในปัจจุบันและอนาคต 
3. ไม่ลอกแบบงานของผู้อื่นและไม่ควรเลียนแบบของโบราณ  แต่ควรออกแบบให้มีเอกลักษณ์ เป็น

ของตัวเอง 

4. มีการศึกษา และปรับปรุงวิธีการออกแบบผลิตภัณฑ์ให้ทันสมัย ตรงตามความต้องการของ 
ผู้บริโภค และสามารถแข่งขันกับตลาดได้ 

5. มีความเข้าใจพ้ืนฐานทางสังคม และความสัมพันธ์ของมนุษย์เป็นหลัก 
6. เป็นนักสังเคราะห์ที่สามารถผลิตงานออกแบบเป็นรูปธรรมและเหมาะสมกับการใช้งานของ 

สภาพสังคมนั้น ๆ  เช่น การสร้างแนวทางใหม่ในการออกแบบที่เป็นเอกลักษณ์ของสังคมไทยยุคใหม่ โดย
เข้าใจรากเหง้าวัฒนธรรมของตนเองอย่างแท้จริง 
 
  
 

องค์ประกอบของการออกแบบผลิตภัณฑ ์

  
 

  ปัจจัยการออกแบบผลิตภัณฑ์ (Design factors)  มีปัจจัยมากมายที่นักออกแบบที่ต้อง คำนึงถึง 
แต่ในที่นี้จะขอกล่าวเพียงปัจจัยพื้นฐาน 10 ประการ ที่นิยมใช้เป็นเกณฑ์ในการพิจารณาสร้างสรรค์ผลงาน
เชิงอุตสาหกรรม ซึ่งปัจจัยดังกล่าวเป็นปัจจัยที่สามารถควบคุมได้ และเป็นตัวกำหนด องค์ประกอบของงาน
ออกแบบผลิตภัณฑ์ที่สำคัญ  ได้แก่ 

1. หน้าที่ใช้สอย (Function) ผลิตภัณฑ์ทุกชนิดจะต้องมีหน้าที่ใช้สอยถูกต้องตามเป้าหมาย ที่ตั้ง
ไว้  คือสามารถตอบสนองประโยชน์ใช้สอยตามท่ีผู้บริโภคต้องการได้อย่างมีประสิทธิภาพ 
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2. ความสวยงามน่าใช้ (Aesthetics or sales appeal) ผลิตภัณฑ์ที่ออกแบบมานั้น จะต้องมี
รูปทรง ขนาด สีสันสวยงาม น่าใช้ ตรงตามรสนิยมของกลุ่มผู ้บริโภค เป้าหมาย เป็นวิธีการเพิ่มมูลค่า
ผลิตภัณฑ์ที่ได้รับความนิยมและได้ผลดี เพราะความสวยงามเป็นความพึงพอใจแรกท่ีคนเราสัมผัสได้ก่อนมัก
เกิดมาจากรูปร่างและสีเป็นหลัก  การกำหนดรูปร่างและสีในงานออกแบบผลิตภัณฑ์  จึงมีความสำคัญ ที่
ผู้ออกแบบต้องให้ความสนใจเป็นพิเศษ 

 3. ความสะดวกสบายในการใช้ (Ergonomics) การออกแบบผลิตภัณฑ์ที่ดีนั้นต้องเข้าใจ กาย
วิภาคเชิงกลเกี่ยวกับขนาด สัดส่วน ความสามารถและขีดจำกัดที่เหมาะสมสำหรับอวัยวะต่างๆ    ของผู้ใช้ 
การเกิดความรู้สึกที่ดีและสะดวกสบายในการใช้ผลิตภัณฑ์ ทั้งทางด้านจิตวิทยา (Psychology) และสรีระ
วิทยา(Physiology) ซึ่งแตกต่างกันไปตามลักษณะเพศ เผ่าพันธุ์ ภูมิลำเนา และสังคมแวดล้อมที่ใช้ผลิตภัณฑ์
นั้นเป็นข้อบังคับในการออกแบบ 

4. ความปลอดภัย (Safety) ผลิตภัณฑ์ที ่เกิดขึ ้นเพื ่ออำนวยความสะดวกในการดำรงชีพ                                                                                                                                                                                                       
ของมนุษย์ มีทั้งประโยชน์และโทษในตัว การออกแบบจึงต้องคำนึงถึงความปลอดภัยของชีวิต          และ
ทรัพย์สินของผู้บริโภคเป็นสำคัญ  ไม่เลือกใช้วัสดุ สี  กรรมวิธีการผลิต  ฯลฯ  ที่เป็นอันตรายต่อผู้ใช้ หรือ
ทำลายสิ่งแวดล้อม  ถ้าหลีกเลี่ยงไม่ได้ต้องแสดงเครื่องหมายเตือนไว้ให้ชัดเจนและมีคำอธิบายการ ใช้แนบมา
กับผลิตภัณฑ์ด้วย 

5. ความแข็งแรง (Construction) ผลิตภัณฑ์ที่ออกแบบมานั้นจะต้องมีความแข็งแรงในตัว  
ทนทานต่อการใช้งานตามหน้าที่และวัตถุประสงค์ที่กำหนดโครงสร้างมีความเหมาะสมตาม คุณสมบัติของ
วัสดุ ขนาด แรงกระทำในรูปแบบต่างๆ จากการใช้งาน 

6. ราคา (Cost) ก่อนการออกแบบผลิตภัณฑ์ควรมีการกำหนดกลุ่มเป้าหมายที่จะใช้ว่าเป็น กลุ่ม
ใด อาชีพอะไร ฐานะเป็นอย่างไร ซึ่งจะช่วยให้นักออกแบบสามารถกำหนดแบบผลิตภัณฑ์และ ประมาณ
ราคาขายให้เหมาะสมกับกลุ่มเป้าหมายได้ใกล้เคียงมากข้ึน 

7. วัสดุ (Materials) การออกแบบควรเลือกวัสดุที่มีคุณสมบัติด้านต่างๆ ได้แก่ ความใส     ผิวมัน
วาว ทนความร้อน ทนกรดด่างไม่ลื่น ฯลฯ ให้เหมาะสมกับหน้าที่ใช้สอยของผลิตภัณฑ์นั้นๆ นอกจากนั้น ยัง
ต้องพิจารณาถึงความง่ายในการดูแลรักษา  ความสะดวกรวดเร็วในการผลิต การสั่งซื้อและคงคลัง รวมถึง
จิตสำนึกในการรณรงค์ช่วยกันพิทักษ์สิ ่งแวดล้อมด้วยการเลือกใช้วัสดุที ่หมุนเวียน กลับมาใช้ ใหม่ได้ 
(recycle) ก็เป็นสิ่งที่นักออกแบบต้องตระหนักถึงในการออกแบบร่วมด้วย  เพื่อช่วย ลดปริมาณขยะของโลก 

8. กรรมวิธีการผลิต (Production) ผลิตภัณฑ์ทุกชนิดควรออกแบบให้สามารถผลิตได้ง่าย 
รวดเร็ว ประหยัดวัสดุ ค่าแรงและค่าใช้จ่ายอื่นๆ แต่ในบางกรณีอาจต้องออกแบบให้สอดคล้องกับ กรรมวิธี
ของเครื่องจักรและอุปกรณ์ที่มีอยู่เดิม  และควรตระหนักอยู่เสมอว่าไม่มีอะไรที่จะลดต้นทุนได้ รวดเร็วอย่าง
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มีประสิทธิภาพ มากกว่าการประหยัดเพราะการผลิตทีละมากๆ 
9. การบำรุงรักษาและซ่อมแซม (Maintenance) ผลิตภัณฑ์ทุกชนิดควรออกแบบให้ สามารถ

บำรุงรักษา และแก้ไขซ่อมแซมได้ง่าย ไม่ยุ่งยาก เมื่อมีการชำรุดเสียหายเกิดขึ้น ง่ายและสะดวกต่อการทำ
ความสะอาดเพ่ือช่วยยืดอายุการใช้งาน รวมทั้งควรมีค่าบำรุงรักษาและการสึกหรอ 

10. การขนส่ง (Transportation) ผลิตภัณฑ์ที่ออกแบบควรคำนึงถึงการประหยัดค่าขนส่ง  
ความสะดวกในการขนส่ง  ระยะทาง เส้นทางการขนส่ง (ทางบก ทางน้ำหรือทางอากาศ ) การกินเนื้อที่ใน
การขนส่ง  ส่วนการบรรจุหีบห่อต้องสามารถป้องกันไม่ให้เกิดการชำรุดเสียหายของ ผลิตภัณฑ์ได้ง่าย กรณีที่
ผลิตภัณฑ์ที่ทำการออกแบบนั้นมีขนาดใหญ่  อาจต้องออกแบบให้ชิ้นส่วน สามารถถอดประกอบได้ง่าย เพ่ือ
ทำให้หีบห่อมีขนาดเล็กลง 
 
 

                            รู้จักโปรแกรม SketchUp 
 

โปรแกรม Google SketchUp เป็นโปรแกรมที่สร้างขึ้นภายใต้แนวคิดในการรวมเอาข้อดีจาก การ
สร้างต้นแบบด้วยการใช้ดินสอเขียนลงบนกระดาษ และใช้สื ่อดิจิตอลในการผสมผสานการใช้งาน  เข้า
ด้วยกัน ทำให้เกิดความยืดหยุ่นในการทำงาน มีระบบ intelligent guidance ซึ่งเป็นระบบที่ใช้ ประโยชน์
จากจุด, เส้น, พื้นผิว เพื่อใช้อ้างอิงในการสร้างโมเดล ทำให้การสร้างงานเป็นไปอย่างลื่นไหล ไม่ต้องการใช้
งานคอมพิวเตอร์ที่มีคุณลักษณะสูงมากนักก็สามารถสร้างโมเดลง่ายๆในเบื้องต้นได้อีก    ทั้งยังมีอินเตอร์เฟส
ที่ใช้งานง่ายไม่ซับซ้อน ส่วนใหญ่จะถูกนำมาใช้ในงานออกแบบเชิงสถาปัตยกรรม งานออกแบบภายในและ
ภายนอก การออกแบบกลไกลการทำงานของเครื่องจักร เฟอร์นิเจอร์           ภูมิประเทศ ผลิตภัณฑ์ รวมไป
ถึงงานออกแบบฉาก อาคาร และสิ่งก่อสร้างในเกม หรือจะเป็นเกม      จัดฉากทำ Story Boards ในงาน
ภาพยนตร์หรือละครโทรทัศน์ก็สามารถทำได้ นอกจากนี้ยังทำงานร่วมกับปลั๊กอิน (Plug in) ต่าง ๆ ที่ถูก
พัฒนาเพื่อช่วยเพิ่มประสิทธิภาพในการทำงานของ Google SketchUp ให้สูงขึ้น ไม่ว่าจะเป็นพลั๊กอินที่ช่วย
ให้การสร้างรูปทรงต่าง ๆ สามารถทำได้ง่ายขึ้น ไปจนถึงปลั๊กอินที่ช่วยในการจัดแสงเงาให้ดูสมจริงอย่างเช่น 
V-Ray หรือ Podium 
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   เริ่มต้นเมื่อเข้าเปิดโปรแกรม SketchUp ครั้งแรกโปรแกรมจะให้เลือก Template และมาตรา
ส่วนหน่วยวัดที่ใช้ และควรที่จะเลือก Template ให้เหมาะสมกับการใช้งาน ซึ่งในแต่ละตัวมีความแตกต่าง
กันในหน้าต่าง Welcome to SketchUp จะมีส่วนที ่ต้องเลือกก่อนเริ ่มต้นใช้โปรแกรม คือ ส่วนของ 
Template ซึ ่งจะเป็นตัวกำหนดหน่วยวัดระยะที ่เราใช ้การเลือก Template สำหรับเริ ่มต้นทำงาน              
มีความสำคัญท่ีต้องตัดสินใจเลือก 2 ส่วน คือ 
 • ทำงานทางด้านใด เช่น ทำงานทั่วไป หรือ ทำงานด้าน Product Design 
 • ใช้หน่วยแบบใด เช่น หน่วยแบบ Feet and Inches ที่แสดงหน่วยเป็นนิ้วหรือฟุต หรือหน่วย 
แบบ Meters ที่แสดงหน่วยเป็น เซนติเมตร หรือ เมตร 

  
 • Simple Template–Feet and Inches และTemplate–Meters เป็นรูปแบบเริ่มต้นเหมาะกับ
การทำงานทั่วไป 
 • Architectural Design–Feet and inches แ ล ะ Architectural Design–Millimeters เ ป็ น
รูปแบบการทำงานที่เหมาะสมกับงานสถาปัตยกรรมและการออกแบบตกแต่งภายใน 
 • Google Earth  Modeling–Feet and Inches แ ล ะ  Google Earth Modeling–Meters  
เป็นรูปแบบที่เหมาะกับการสร้างโมเดล เพ่ือใช้สำหรับโปรแกรม Google Earth 
 • Engineering –Feet และ Engineering–Meters เป ็นร ูปแบบการทำงานท ี ่ เหมาะก ับงาน 
วิศวกรรม 
 • Product Design and Woodworking– Inches และ  product Design and Woodworking 
Millimeters เป็นรูปแบบที่เหมาะกับงานชิ้นเล็ก ๆ และงานเฟอร์นิเจอร์ Template นี้จะมีหน่วยวัดที่
ละเอียดถึงมิลลิเมตร 
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 • Plan View–Feet and Inches และ Plan View–Meters จะเป็นการทำงานที ่มีมุมมองแบบ 
แปลน 2 มิต ิ
 นอกจากหน่วยการทำงานที ่เปลี ่ยนไปแล้ว ในการเลือก Template ว่าจะทำงานด้านใดในตัว 
Template เองจะมีรายละเอียดอ่ืน ๆ เช่น สไตล์ของเส้น และรายละเอียดอ่ืน ๆ ที่แตกต่างกันไปด้วย ซึ่งสิ่ง
เหล่านี ้สามารถมองเห็นได้จริง ๆ เมื ่อเริ ่มวาดภาพหรือทำงานในโปรแกรมแล้ว หากต้องการเปลี ่ยน 
Template หลังจากที่เปิดโปรแกรมแล้ว ทำได้โดยการคลิกที่เมนู Window –> Preference จากนั้นคลกิท่ี 
Template ใหม่ที่ต้องการ โดย Template ที่เปลี่ยนจะมีผลเมื่อเปิดโปรแกรมครั้ง ต่อไป 
 

 
 

  ในการออกแบบโครงสร้างตัวอาคาร ผลิตภัณฑ์ต่าง ๆ จำเป็นต้องอาศัยความแม่นยำ และเจาะจง 
เพื่อให้ชิ้นงานที่ออกมานั้นสามารถนำไปใช้ได้จริง โปรแกรม Google SketchUp มีแกน อ้างอิงไว้ให้ใช้เป็น
แกนหลักในการวาดภาพและขึ้นโมเดล รวมทั้งการทำงานอื่น ๆ ซึ่งเมื่อปิดโปรแกรมขึ้นมาจะพบแกนอ้างอิง
ดังภาพ 

 
 

จากภาพจะพบแกนอ้างอิงทั้งหมด 3 แกน วางตัดกัน ได้แก่ แกนสีแดง (Red Axis) แกนสีเขียว 
(Green Axis) และแกนสีน้ำเงิน (Blue Axis) ซึ่งใช้งานตามรูปแบบของแกน 3 มิติ (X, Y, Z) ส่วนจุดตัดของ
แกนทั้ง 3 เรียกว่า จุดกำเนิด (origin) 

การจัดวางแกนอ้างอิงในโปรแกรม SketchUp เป็นรูปแบบมาตรฐานที่คนส่วนใหญ่ใช้กันเรา
สามารถกำหนดรูปแบบและลักษณะการวางแกนได้เอง ทั้งนี้  เพื่อความสะดวกในการทำงาน และความถนัด
ของแต่ละคน โดยคลิกขวาที่แกนที่ต้องการจะปรากฏคำสั่งให้เลือก ดังนี้ คลิกขวาที่แกน ที่ต้องการทำงานจะ
ปรากฏเมนูคำสั่งออกมา 
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หลักสูตรท้องถิ่น ใบงานที่ 1.1 
เรื่อง ความหมายของการออกแบบ

ผลิตภัณฑ์ 

ใช้เวลาปฏิบัติงาน 30 นาที 

เรื่อง งานไม้สวยด้วย 
SketchUp 

ชื่อผู้สอน 
นางหนึ่งฤทัย พุทธแก้ว 

 

กลุ่มท่ี.................................. 
สมาชิก 1.....................................................           5........................................................... 
          2...................................................... 6.......................................................... 
          3...................................................... 7.......................................................... 
          4...................................................... 8........................................................... 
คำชี้แจง ให้นักเรียนใช้เวลา 30 นาที ในการทำกิจกรรมดังต่อไปนี้ 
1. นักเรียนแบ่งออกเป็นกลุ่ม ๆ ละประมาณ 6-8 คน เลือกประธาน รองประธานและเลขานุการ 
2. ให้นักเรียนอภิปรายในกลุ่ม เรื่อง ความสำคัญของการออกแบบผลิตภัณฑ์ 
3. สรุปผลการอภิปรายโดยสร้างเป็นผังความคิดลงในใบงานและบนแผ่นกระดาษท่ีแจกให้แล้ว 
   ส่งตัวแทนออกไปรายงานผลหน้าชั้น โดยใช้เวลากลุ่มละประมาณ 3 นาที 
ผลการปฏิบัติงาน  
   1. ชื่อประธาน............................................................................................. .  
   2. ชื่อรองประธาน.......................................................................................  
   3. ชื่อเลขานุการ...................................................................................... ...  
 

ผังความคิดเรื่อง ความหมายของการออกแบบผลิตภัณฑ์ 
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หลักสูตรท้องถิ่น ใบงานที่ 1.2 
เรื่อง ความสำคัญของการออกแบบ

ผลิตภัณฑ์  

ใช้เวลาปฏิบัติงาน 30 นาที 

เรื่อง งานไม้สวยด้วย 
SketchUp 

ชื่อผู้สอน 
นางหนึ่งฤทัย พุทธแก้ว 

ชื่อนักเรียน ...........................................................................ชั้น.....................เลขที.่................ 

 
คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  
 

1. ให้นักเรียนอธิบายความสำคัญของการออกแบบผลิตภัณฑ์มาอย่างน้อย 5 ข้อ 
ตอบ ...............................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  

2. ให้นักเรียนยกตัวอย่างการสร้างเอกลักษณ์ของผลิตภัณฑ์มา 1 ผลิตภัณฑ์ 
ตอบ ................................................................................................... ............ 
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
.......................................................................................................................  
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หลักสูตรท้องถิ่น ใบงานที่ 1.3 
เรื่อง คุณสมบัติ องค์ประกอบ 

ของผลิตภัณฑ์ 

ใช้เวลาปฏิบัติงาน 30 นาที 

เรื่อง งานไม้สวยด้วย 
SketchUp 

ชื่อผู้สอน 
นางหนึ่งฤทัย พุทธแก้ว 

ชื่อนักเรียน ...........................................................................ชั้น.....................เลขที.่................ 

 
คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  
 

1. ให้นักเรียนอธิบายคำว่า “ความแปลกใหม่” คือ  
ตอบ ...............................................................................................................  
................................................................................................. ...................... 

2. ให้นักเรียนอธิบายคำว่า “ราคาพอสมควร” คือ 
ตอบ................................................................................................................  
.......................................................................................................................  

3. ให้นักเรียนอธิบายคำว่า “เป็นที่ยอมรับ (Regional acceptance)” คือ 
ตอบ ...............................................................................................................  
............................................................................................... ........................ 
.......................................................................................................................  
............................................................................................................... ........ 
.......................................................................................................................  

4. การออกแบบผลิตภัณฑ์มีปัจจัย (Design factors)  อะไรบ้าง 
ตอบ ..................................................................... .......................................... 
.......................................................................................................................  
............................................................................................. .......................... 
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หลักสูตรท้องถิ่น 
ใบงานที่ 1.4 

เรื่อง รู้จักโปรแกรม Sketchup 

ใช้เวลาปฏิบัติงาน 30 นาที 

เรื่อง งานไม้สวยด้วย 
SketchUp 

ชื่อผู้สอน 
นางหนึ่งฤทัย พุทธแก้ว 

ชื่อนักเรียน ...........................................................................ชั้น.....................เลขที่................. 

 
คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  
 

1. บอกคุณสมบัติและความสามารถของโปรกรม SketchUp มาอย่างละเอียด  
ตอบ ...............................................................................................................  
.......................................................................................................................  
.......................................................................................................................  

2. บอกรุ่นของซอฟต์แวร์ หรือ เวอร์ชั่นของโปรแกรม SketchUp ในปัจจุบันมีอะไรบ้าง 
ตอบ.................................................................................. .............................. 
.......................................................................................................................  
......................................................................................................... .............. 

3. บอกความต้องการของระบบปฏิบัติการติดตั้งโปรแกรม SketchUp  
ความต้องการของระบบ 
ระบบปฏิบัติการ  
ความเร็ว CPU  

หน่วยความจำ RAM  

เนื้อท่ีว่างใน Hard-disk  

การ์ดแสดงผล  

เมาส์  

ซอฟต์แวร์ที่จำเป็น  
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หลักสูตรท้องถิ่น ใบงานที่ 1.5 
เรื่อง การเรียกใช้โปรแกรม 

Sketchup 

ใช้เวลาปฏิบัติงาน 30 นาที 

เรื่อง งานไม้สวยด้วย 
SketchUp 

ชื่อผู้สอน 
นางหนึ่งฤทัย พุทธแก้ว 

ชื่อนักเรียน ...........................................................................ชั้น.....................เลขที.่................ 

 
คำชี้แจง  ให้นักเรียนตอบคำถามต่อไปนี้ให้ถูกต้อง  
 

1.  Title Bar (แถบไตเติลบาร์) คือ .................................................................... ............... 
2.  Menu Bar (แถบเมนูบาร์) คือ ..................................................................................... 
3.  ชุดเครื่องมือ Getting Started คือ ........... ................................................................... 
4.  ชุดเครื่องมือ Large Tool set คือ .............................................................................. 
5.  จงบอกส่วนประกอบของโปรแกรม SketchUp ให้ถูกต้อง 

 

 
 
 
 

Title Bar 
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แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
หน่วยการเรียนรู้ที่ 1 ช่ือหน่วย สำรวจข้อมูลพื้นฐาน 

 

คำชี้แจง  แบบทดสอบมีจำนวน 20 ข้อ 20 คะแนน ใช้เวลาทำแบบทดสอบ 30 นาที 

คำสั่ง  จงเลือกคำตอบที่ถูกที่สุดเพียงคำตอบเดียวแล้วกากบาทลงในกระดาษคำตอบ 
 

 1.  คุณสมบัติที่ดีของงานออกแบบผลิตภัณฑ์ใดสำคัญน้อยที่สุด 
ก. มีราคาขายพอสมควร (price) 
ข. มีเรื่องราวที่มา (story) 
ค. มีความแปลกใหม่ (innovation) 
ง. วางตลาดในเวลาที่เหมาะสม (timing)  

2.  ข้อใดเป็นสมบัติด้านวิชาชีพด้านจริยธรรมที่สำคัญที่สุดของนักออกแบบผลิตภัณฑ์ 
ก. มีความชำนาญในการแก้ปัญหา 
ข. มีทักษะประสบการณ์ออกแบบ 
ค. มีมนุษย์สัมพันธ์กับเพ่ือนร่วมงาน 
ง. ไม่มีพฤติกรรมลอกเลียนแบบงานผู้อื่น 

 3.   ข้อใดเป็นการออกแบบผลิตภัณฑ์ที่เน้นความสะดวกสบายในการใช้สอย 
ก. เก้าอ้ีที่ทำจากวัสดุแข็งแรง ทนทาน 
ข. เก้าอ้ีมีสัดส่วนนั่งแล้วรู้สึกสบาย 
ค. เก้าอ้ีมีระบบแสงเสียงอัตโนมัติ 
ง. เก้าอ้ีมีระบบไฟฟ้าขับเคลื่อนที่ 

4.   ข้อใดคือลักษณะบ่งชี้ความเป็นการออกแบบ 
ก. เป็นกิจกรรมการใช้วัสดุต่าง ๆ มาทำประโยชน์ 
ข. เป็นกิจกรรมการทำงาน เพื่อให้ได้กำไร 
ค. เป็นกิจกรรมแก้ปัญหา เพ่ือให้ได้ผลที่ดีกว่าเดิม 
ง. เป็นกิจกรรมใช้ความคิด เพ่ือหาคำตอบของปัญหา 
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5.  ข้อใดคือ ความคิดสร้างสรรค์ ของการนำกระสอบป่านมาตกแต่งลวดลายให้สวยงามน่าสนใจ 
   ก. ความคิดริเริ่ม 
  ข. ความคิดละเอียดลออ 

    ค. ความคล่องในการคิด 
   ง. ความยืดหยุ่นในการคิด 
 6.  ปัจจัยการออกแบบผลิตภัณฑ์จะต้องพิจารณาถึงคุณภาพในเรื่องความคงทนถาวร  
             เป็นปัจจัยที่สัมพันธ์กับข้อใด 

ก. คุณภาพผลิตภัณฑ์                     
ข. คุณค่าความสวยงาม 
ค. ความต้องการของผู้บริโภค                                          
ง. วัสดุและกระบวนการผลิต 

7.  ข้อใดคือ การออกแบบสิ่งของเครื่องใช้เพื่อนำมาใช้ในชีวิตประจำวัน 
ก. Design 
ข. Desire 
ค. Desearch 
ง. Product Design 

8.  ข้อใดคือความสำคัญของการออกแบบผลิตภัณฑ์ เพ่ือประโยชน์ใช้สอยประจำวัน 
    ก.   คุณค่าทางกาย 
  ข.   คุณค่าทางเจตคติ 
  ค.   คุณค่าทางเศรษฐกิจ 

    ง.   คุณค่าทางอารมณ์และความรู้สึก 
        9.  ผลิตภัณฑ์ใดที่ประดิษฐ์จากวัสดุที่มีอยู่ทั่วไปในท้องถิ่น 

ก. ราวตากผ้าจากไม้ไผ่ 
ข. ตะกร้าจากกระดาษโทรศัพท์ 
ค. เข็มกลัดติดเสื้อจากดอกตะแบก 

       ง.    ถังขยะจากกระป๋องสี 
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10.  ผลิตภัณฑ์ที่ผลิตออกมาแล้วไม่ซ้ำแบบใคร ถือเป็นงานที่เกิดจากสิ่งใด 
ก.  ความคิดริเริ่มสร้างสรรค์ 
ข.  การนำความรู้ทางศิลปะมาใช้ 
ค.  การนำความรู้มาประยุกต์ใช้ 
ง.   ประสบการณ์และการฝึกฝน 

11.  โปรแกรม Google Sketch up เหมาะกับการใช้งานในด้านใด 
    ก.   เพ่ือใช้ในการพัฒนาโปรแกรมตามความต้องการของผู้ใช้งาน 

ข.   เพ่ือใช้ในงานออกแบบสิ่งของเครื่องใช้ตามความต้องการของผู้ใช้งาน 
ค.   เพ่ือใช้ในงานแอนนิเมชั้นสร้างข้อความหรือการ์ตูนและภาพเคลื่อนไหว 
 ง.   เพ่ือใช้ในการนำเสนอผลงานทางวิชาการและเหมาะสำหรับการเผยแพร่งาน 

12.  คำว่า Google Sketch Up คืออะไร 
ก.  โปรแกรมท่ีเผยแพร่ภาพฟรีสำหรับงานต่าง ๆ 
ข.  โปรแกรมสำหรับงานดีไซน์ฉากโลโก้ภาพ 3 มิติ 
ค.  โปรแกรมสำหรับการออกแบบ Model 3 มิติ งานจำลอง 

      ง.   โปรแกรมสำหรับวาดเส้นแบบ Vector 
13.  ข้อใดคือผลงานที่สร้างขึ้นด้วยโปรแกรม Google Sketch up  

ก. งาน 3D 
ข. งาน Animation 
ค. งานสร้างสรรค์ 

      ง.   งานออกแบบสิ่งของ 
14.  Google Sketch Up สามารถประยุกต์ใช้กับงานทางด้านใด 

ก. สถาปัตยกรรมและการออกแบบ 
ข. วิศวกรก่อสร้าง 
ค. สร้างเกม 

      ง.    ถูกทุกข้อ 
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15.  บุคคลใดควรเลือกใช้โปรแกรม Google Sketch up ในการประกอบอาชีพ 
ก. มดเป็นผู้จัดการธนาคาร 
ข. ดำเป็นหัวหน้าแผนกสินเชื่อ 
ค. นิดเป็นสถาปนิกออกแบบอาคาร 

      ง.    หน่อยเป็นไกด์นำเท่ียวต่างประเทศ 
16.  คำสั่งใดคือเลือกมุมมองการทำงานก่อนเข้าสู่โปรแกรม 

ก. Learn More 
ข. Choose Template 
ค. Always show on start up 

      ง.    Start using Sketch up 
 17.  ข้อใดคือขั้นตอนการเปิดแถบเครื่องมือต่าง ๆ ท่ีต้องการใช้งานอย่างถูกต้อง 

ก. เลือกเมนูและคำสั่งต่อไปนี้ View>Toolbar แล้วเลือกเครื่องมือท่ีต้องการ 
ข. เลือกเมนูและคำสั่งต่อไปนี้ Tool>Toolbar แล้วเลือกเครื่องมือท่ีต้องการ 
ค. เลือกเมนูและคำสั่งต่อไปนี้ Window>Toolbar แล้วเลือกเครื่องมือท่ีต้องการ 
ง.    เลือกเมนูและคำสั่งต่อไปน้ี Draw>Toolbar แล้วเลือกเครื่องมือท่ีต้องการ 

 18.  ข้อใดคือแกนหลักในการทำงานของโปรแกรม Google SketchUp 
ก. มี 2 แกน ได้แก่ สีเหลืองและสีแดง 
ข. มี 3 แกน ได้แก่ สีเขียว,สีน้ำเงินและสีแดง 
ค. มี 4 แกน ได้แก่ สีเขียว,สีน้ำเงิน,สีเหลืองและสีแดง 
ง.    มี 5 แกน ได้แก่ สีเขียว,สีน้ำเงิน,สีเหลือง,สีแดงและสีขาว 

 19.  ข้อใดคือหลักการทำงานของแกนสีน้ำเงิน 
ก. บอกตำแหน่งสิ้นสุด ปลายสุด 
ข. บอกตำแหน่งของเส้นขอบ 
ค. บอกตำแหน่งท่ีเป็นจุดตัดของเส้นประกอบ 
ง.    บอกตำแหน่งบนพื้นผิววัตถุ หรือบน face 

 20.  ข้อใดคือหลักการทำงานของแกนสีแดง 
ก. บอกตำแหน่งสิ้นสุด ปลายสุด 
ข. บอกตำแหน่งของเส้นขอบ 
ค. บอกตำแหน่งท่ีเป็นจุดตัดของเส้นประกอบ 
ง.    บอกตำแหน่งบนพื้นผิววัตถุ หรือบน face 
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กระดาษคำตอบ 

 

ชื่อ .....................................................สกุล .................................................ชั้น ม. ..... .........เลขที่ ............ 

 

 

 

 

 

คะแนนเต็ม คะแนนที่ได้ 

  

 

ข้อ ก ข ค ง ข้อ ก ข ค ง 

1     11     

2     12     

3     13     

4     14     

5     15     

6     16     

7     17     

8     18     

9     19     

10     20     
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เอกสารอ้างอิง 

 

ถวัลย์ มาสจรัส และมณี เรืองขำ. (2549). แนวการจัดกิจกรรมการเรียนการสอนโครงงาน. กรุงเทพฯ :  
ธารอักษร. 

กระทรวงศึกษาธิการ สำนักงานคณะกรรมการการศึกษาขั้นพ้ืนฐาน 2551 (มป.ป.). ตัวช้ีวัดและสาระการ
เรียนรู้แกนกลาง กลุ่มสาระการงานอาชีพและเทคโนโลยี. กรุงเทพฯ : ชุมนุมสหกรณ์การเกษตร
แห่งประเทศไทย จำกัด. 

จุฑามาศ จิวะสังข์. (2555). สร้างโมเดล 3 มิติด้วยโปรแกรม Google SketchUp8+โปรแกรมฉบับ
สมบูรณ์. กรุงเทพฯ : ซิมพลิฟาย. 

จุฑามาศ จิวะสังข์. SketchUp Pro 6.0. พิมพ์ครั้งที่ 1. กรุงเทพฯ : บริษัท ซัคเซส มีเดีย จำกัด, 2550. 
นวอร แจ่มขำ. (2555). มือใหม่หัดใช้ SketchUp 8 สร้างโมเดลสวย ด้วยวิธีง่าย ๆ / นวอร แจ่มขำ และ

พรรณธิพา บ่มกลาง. ห้องสมุดมหาวิทยาลัยสงขลานครินทร์ วิทยาเขตตรัง 
บุญทรัพย์ วิชญางกูร. (2556). easy SketchUp 8 + V-ray :เรียนรู้การใช้งานตั้งแต่พื้นฐานไปจนถึงระดับ

มืออาชีพ. นนทบุรี : ไอดีซีฯ, 2556 
blogspot.com (2556).โปรแกรม Google SketchUp . (ออนไลน์). 21 พฤศจิกายน 2557.                                    

จาก http://0868583949.blogspot.com/2013/04/google-sketchup_29.html 
blogspot.com (2556).โปรแกรม Google SketchUp . (ออนไลน์). 21 พฤศจิกายน 2557.                                    

จาก http://0868583949.blogspot.com/2013/04/google-sketchup_29.html  
 
 

http://0868583949.blogspot.com/2013/04/google-sketchup_29.html

